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Legal Notices
Warranty
The only warranties for products and services of Micro Focus and its affiliates and licensors (“Micro Focus”) are set forth in the express warranty statements accompanying
such products and services. Nothing herein should be construed as constituting an additional warranty. Micro Focus shall not be liable for technical or editorial errors or
omissions contained herein. The information contained herein is subject to change without notice.

Restricted Rights Legend
Confidential computer software. Except as specifically indicated otherwise, a valid license from Micro Focus is required for possession, use or copying. Consistent with FAR
12.211 and 12.212, Commercial Computer Software, Computer Software Documentation, and Technical Data for Commercial Items are licensed to the U.S. Government
under vendor's standard commercial license.

Copyright Notice
© 2019 Micro Focus or one of its affiliates.

Trademark Notices
Adobe® is a trademark of Adobe Systems Incorporated.
Microsoft® and Windows® are U.S. registered trademarks of Microsoft Corporation.
Oracle and Java are registered trademarks of Oracle and/or its affiliates.
Linux® is the registered trademark of Linus Torvalds in the U.S. and other countries.

Disclaimer
Certain versions of software and/or documents (“Material”) accessible here may contain branding from Hewlett-Packard Company (now HP Inc.) and Hewlett Packard
Enterprise Company. As of September 1, 2017, the Material is now offered by Micro Focus, a separately owned and operated company. Any reference to the HP and Hewlett
Packard Enterprise/HPE marks is historical in nature, and the HP and Hewlett Packard Enterprise/HPE marks are the property of their respective owners.

Documentation Updates
To check for recent updates or to verify that you are using the most recent edition of a document, go to: https://softwaresupport.softwaregrp.com.
This site requires that you register for a Software Passport and to sign in. To register for a Software Passport ID, click Register for Software Passport on the Micro Focus
Support website at https://softwaresupport.softwaregrp.com.
You will also receive updated or new editions if you subscribe to the appropriate product support service. Contact your Micro Focus sales representative for details.

Support
Visit the Micro Focus Support site at: https://softwaresupport.softwaregrp.com.
This website provides contact information and details about the products, services, and support that Micro Focus offers.
Micro Focus online support provides customer self-solve capabilities. It provides a fast and efficient way to access interactive technical support tools needed to manage your
business. As a valued support customer, you can benefit by using the support website to:
l
l
l
l
l
l
l
l

Search for knowledge documents of interest
Submit and track support cases and enhancement requests
Download software patches
Manage support contracts
Look up support contacts
Review information about available services
Enter into discussions with other software customers
Research and register for software training

Most of the support areas require that you register as a Software Passport user and to sign in. Many also require a support contract. To register for a Software Passport ID,
click Register for Software Passport on the Micro Focus Support website at https://softwaresupport.softwaregrp.com.
To find more information about access levels, go to: https://softwaresupport.softwaregrp.com/web/softwaresupport/access-levels.
Integration Catalog accesses the Micro Focus Integration Catalog website. This site enables you to explore Micro Focus Product Solutions to meet your business needs,
includes a full list of Integrations between Micro Focus Products, as well as a listing of ITIL Processes. The URL for this website is
https://softwaresupport.softwaregrp.com/km/KM01702731.
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What's new in this release
This section describes the important changes in this release.
Tip: The following knowledge base article contains links to all the previous 9.5x release notes and
patches. This article enables you to always find the most up-to-date release notes and the latest
9.5x patches.
Overview of Service Manager 9.5x Releases

New JavaScript method
Service Manager 9.52p6 introduces the following new JavaScript method.

JavaScript method: SCFile.doSelectEx()
The SCFile.doSelectEx() method is designed to improve the system performance. You can restrict the
data retrieval by specifying the start and count parameters. In comparison, the legacy
SCFile.doSelect() method retrieves data from the beginning and may cause potential performance
issue on large tables.
Syntax
SCFile_object.doSelectEx( query, start, count );
Arguments
The following arguments are valid for this method:
Data
Argument type

Description

query

String

This argument specifies the query you want to use to search for Service
Manager records. You must use the slash character to escape out quotation
marks and any special characters restricted from JavaScript.

start

Number This argument specifies the start record of query results.

count

Number This argument specifies the get count from start.

Return values

Service Manager (9.52)
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A SCFile object containing records and RC_SUCCESS or one of the other global return code values.
The method returns an SCFile object containing the records matching the (query,start,count) and a
global return code value of RC_SUCCESS or returns one of the error global return code values if the
method cannot return any records.
Example
This example does the following:
l

Searches the device table from 1000 for 1 record

l

Displays the device record as a text string

This example requires the following sample data:
l

A device table records >=1001

var deviceFile = new SCFile( "device" );
var rc = deviceFile.doSelectEx( "true", 1000, 1 )
if ( rc == RC_SUCCESS )
{
print( "Success. found 1 record in device table:" + deviceFile);
}
else
{
print( "Could not find any record from device table" );
}

Certifications
Service Manager 9.52 Patch 6 includes the following certification changes.

Added support
Server
l

Red Hat Enterprise Linux 7.4, 6.10.

Mobility
l

iOS 12.x

l

Android 9.x, 8.x

Service Manager (9.52)
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Discontinued support
Support for the following item has been discontinued.
Web tier
l

Apache HTTP Server 2.2

SRC
l

Apache HTTP Server 2.2

Service Manager Collaboration
l

Apache HTTP Server 2.2

Mobility
l

Android 4.x, 5.x, 6.x

Deprecation and obsolescence
Deprecated items
A deprecated item is categorized as a component/feature/parameter for which there will be no further
enhancement. It will continue to be supported till a notice of obsolescence is published. In addition, bug
fixes and support cases will be handled till such time that the deprecated item becomes obsolete.
There are no deprecated items in this release.

Obsoleted items
An obsoleted item is categorized as a component/feature/parameter that is no longer supported.
The following items are no longer supported.

Service Manager (9.52)
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Item

Notes

Android 4.x, 5.x, 6.x

Drop from Service Manager Mobility.

Apache HTTP Server 2.2

Drop from Service Manager web tier, Collaboration and SRC.
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Enhancements
This release includes the following enhancements.

Server
CR

Problem

Solution

QCCR1E156306 Red Hat Enterprise Linux 6.10 is not certified for Service
Manager 9.52.

Red Hat Enterprise Linux 6.10 is now certified for Service
Manager 9.52.

QCCR1E143926 Red Hat Enterprise Linux 7.4 is not certified for Service
Manager 9.52.

Red Hat Enterprise Linux 7.4 is now certified for Service
Manager 9.52.

Mobility
CR

Problem

Solution

QCCR1E157123 iOS 12.x is not certified for Service Manager Mobility.

iOS 12.x is now certified for Service Manager Mobility.

QCCR1E157124 Android 8.x is not certified for Service Manager Mobility.

Android 8.x is now certified for Service Manager Mobility.

QCCR1E157125 Android 9.x is not certified for Service Manager Mobility.

Android 9.x is now certified for Service Manager Mobility.

Service Manager (9.52)
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Fixed defects
This release fixes the following defects.

Server
CR

Problem

QCCR1E145755 The system displays the following error message when a
view queries two tables.

Solution
The system no longer displays error messages when a view
queries two tables.

Unable to locate field x in any file.
QCCR1E150827 No confirmation window is displayed when cancelling your
updates to an Incident.

Now after you create or update an Incident, fill all required
fields and then cancel your operations, the system displays
the You have unsaved changes to this record. Save
them now? pop-up message.

QCCR1E151036 After the customers create CI relationship unloads from
Service Manager 9.52 and then load the records to another
Service Manager 9.52 environment, the system displays the
following error messages

Now you can load the CI relationships successfully without
signal 11 errors.

Your Server Session may have been temniated or
time out..........
SOAP Fault occurred: A signal 11 was raised in

Service Manager (9.52)
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native code........
QCCR1E152345 If you modify the Status, Assignment group, or Description
field of an Incident and then click Cancel without saving the
modifications, you are logged out from Service Manager.
There is a signal 11 error in the log and a core dump file is
generated.

Now when you click Cancel, Service Manager works well
with no signal 11 errors and no longer generates a core dump
file.

QCCR1E152483 The RESTful performance is poor when you use the start
parameter to iterate a large table.

Now we have added SQL Paginition and the RESTful
performance is improved.
Note: You need to import the QCCR1E152483_
SM952P6_SM934.unl unload file to apply this fix.

QCCR1E153275 After you escalate an Interaction to an Incident from the
ESS portal, the linker process gets terminated.

Now after you escalate an Interaction to an Incident from the
ESS portal, the linker process works well.

QCCR1E153274 IR search does not work for some Japanese words.

Now IR search works fine for all the IR fields.

QCCR1E154025 Service Manager server cannot verify the client certificate
during SSL handshake when the Distinguished Name (DN)
of a client SSL certificate has EMAILADDRESS as the first
attribute instead of CN.

Now Service Manager server can verify the client certificate
during SSL handshake when the Distinguished Name (DN)
of a client SSL certificate has EMAILADDRESS as the first
attribute instead of CN.

QCCR1E156029 Service Manager processes terminate with core dumps.

Service Manager processes work fine without core dumps.

QCCR1E154542 The emails that are created by Smart Email have incorrect
titles if they contain umlauts.

Now the emails that are created by Smart Email have
correct titles.

Web client
CR

Problem

Service Manager (9.52)
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QCCR1E153165 The drill-down functionality in a vertical bar report does not
show the same number of records as the bar displays. When
you click one of the bars, the system returns a sum of the
records in the same group.

Now the drill-down functionality in a vertical bar report works
correctly. When you click one of the bars, the system
returns only the list of records of the column that you are
clicking.
Note: You need to import the QCCR1E153165_
SM952P6_SM952.unl unload file to apply this fix.

QCCR1E154335 The Affected CI field in the Task Planner displays the logical
name instead of the display name.

The Affect CIs fields show the display name in the
Predefined Additional Task Fields of a planned task.
Note: You need to import the QCCR1E154335_
SM952P6_SM950.unl unload file to apply this fix.

QCCR1E137193 If the data in a record list contains the unicode line separator
character, the system displays the record list as a blank
section. You can see the following JavaScript error in the
browser console

Now the system displays the record list correctly even if its
data contains the unicode special characters such as a line
separator or a paragraph separator, or the Unicode
supplementary characters (such as an emoji).

Uncaught SyntaxError: Invalid or unexpected token
QCCR1E153039 Suppose there are two Comfill fields on a form with the auto
complete function enabled. You have used the auto
complete function to fill the first Comfill field (for example,
the value is new1). However, when you try to use the auto
complete function to fill the sencond Comfill field and the
first three letters of the desired value are the same with that
in the first Comfill (for example, the value is new2), the
system automatically fills new1 in the sencond Comfill and
you cannot change this value.

Now in this case, the auto complete function for the second
Comfill field works well.

QCCR1E153295 The Open Smart Search Widget button action for the Smart
Search buttons and link labels does not work in the web
client accessible views (accessible.do).

Now this issue is fixed.

QCCR1E154898 Suppose you have opened an item in the Catalog and then

Now the radio buttons are displayed properly.

Service Manager (9.52)
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add some user options. After you click User Selections >
Preview, no radio buttons are displayed on the page. In
addition, if you order the Accounts Payable catalog item on
the Order from catalog page, the system does not display
the radio button, too.
QCCR1E155031 Displaying a dynamic form sometimes causes
NullPointerException.

Displaying a dynamic form is always successful.

QCCR1E155895 Some unicode characters (such as emoji) in dynamic form
elements are not working correctly in web client.

Special unicode characters (such as emoji) in dynamic form
elements are now working correctly in web client.

QCCR1E157204 jsError occurs when pressing Enter on the language combo
box in the login page.

jsError no longer occurs when pressing Enter on the
language combo box in the login page.

Windows client
CR

Problem

QCCR1E156036 Users cannot input emoji characters to the dynamic form
fields in Windows client.

Solution
Users can now input emoji characters to the dynamic form
fields in Windows client.

Known issues, limitations, and workarounds
Service Manager 9.52p6 has the following known issues and limitations. This is a cumulative list of known issues and limitations in Service
Manager, including those that are already documented in previous release notes.
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Introduced
in version

Global ID

Component

Issue

QCCR1E143962

Web Client

In Service Manager, the hotkey "Alt+J" lets you jump to a section in a detail form. However, 9.52
after the Internet Explorer 11.1715.14393.0 upgrade, this hotkey opens the built-in "Internet
Explorer feedback" and cannot be used by Service Manager any more.

QCCR1E139374

Localization

Some text strings that are introduced by the Service Portal search enhancement in Service
Manager 9.52 are unlocalized.

9.52

QCCR1E139375

Localization

Some text strings that are displayed on the Add Supplier UI in the Swedish version of
Service Portal are unlocalized.

9.52

QCCR1E139372

Service Portal

"Service Portal" is not translated correctly to "Portal de Servicios" in the Spanish version of
Service Portal.

9.52

QCCR1E137795

Mobility

The keyboard is not displayed when you tap the Search Knowledge field on Mobility ESS
on an Android device.

9.51

Workaround: Click the Search icon first, and then tap the Search Knowledge field.
QCCR1E131803

Service
Request
Catalog

When two line items in the "Open New Request" Catalog Connector information section for 9.51
a catalog item have the same description (but different part numbers), the incorrect line item
is removed when you try to remove one of the line items.
Workaround:
1. Open the "svcCat RM Quote - Delete Part from Request 2" wizard.
2. Go to Tab Actions > Expressions.
3. Change:
$value=$this.position in $part
To:
$this.part.no= $this.position in $component.part.no

Service Manager (9.52)
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Global ID

Component

Introduced
in version

Issue
4. Change:
$this.part.no=jscall("svcCatInterface.getPartNo", $value, "model")
To:
if null($this.part.no) then ($this.part.no=jscall
("svcCatInterface.getPartNo", $value, "model"))

QCCR1E127396

Service
Manager
server

There are memory leaks in Oracle Client 12.1.0.1.0 and in Oracle Client 12.1.0.2.0.

QCCR1E136984

Documentation The search function in the Help Center does not work on pages that contain interactive
tables.

9.50

QCCR1E136998

Integration

9.50

When the UCMDB Browser is embedded in UCMDB, the Get Related and Impact
Simulation widgets that are embedded in Service Manager do not work.

9.50

Workaround:
1. Stop the UCMDB server.
2. Replace the <UCMDB installation path>\UCMDBServer\deploy\ucmdbbrowser.war file with the file extracted from the HPE-Browser-4.12.61-ucmdbbrowser-embedded.zip file in the browser 4.12 release build.
3. Delete <UCMDB installation path>\<UCMDB Server\runtime\jetty-cache.
4. Restart the UCMDB server.
5. Log in to the UCMDB JMX Console and set the value of the "ui.framing.host"
global setting to the Service Manager webtier domain URL (for example,
http://16.165.217.47:8090) from which Service Manager will access the embedded
UCMDB browser.
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Introduced
in version

Global ID

Component

Issue

QCCR1E137165

Service Portal

The QMS component in Smart Analytics does not support SSL to communicate with
Service Portal (or Propel) search.

9.50

Workaround: You can change the QMS port value to the IDOL query port to bypass
QMS. To do this, follow these steps:
1. Edit the /opt/hp/propel/search/search.yml file.
# vi /opt/hp/propel/search/search.yml
2. Search for "qms" in the "idol" section, and then modify the port value from the QMS
port (16000 by default ) to the IDOL Server port (14000 by default) as in the
following example:
…
qms:
hostname: <IDOL server FQDN>
port: 14000
oemKey: <oemKey value>
executionIsolationThreadTimeoutInMillis: 80000
threadpool:
threadPoolCoreSize: 10
keepAliveTimeMinutes: 1
…
3. Run the following commands to restart the search service:
# service search stop
# service search start
QCCR1E135332

Service Portal

When Smart Analytics is enabled, type-ahead is not suggested from knowledge library
when you search Knowledge Library.

9.50

QCCR1E136810

Applications

User Option values are not passed to the OO Flow if a Change Task is opened in the first
phase during run time.

9.50

Service Manager (9.52)
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Issue

Introduced
in version

QCCR1D231005 Service Portal

When you remove an organization from identity management, Servicce Portal times out.

9.50

QCCR1D218198 Service Portal

After changing the master password, the Servicce Portal organizations are no longer
accessible.

9.50

QCCR1E136061

Records are renamed in Service Manager after you apply the Service Portal 2.20p1 unload
to Service Manager 9.41 and then upgrade to Service Manager 9.50.

9.50

QCCR1D230491 Service Portal

The "Associated Service" field in the KM template is not displayed correctly in Service
Portal.

9.50

QCCR1D230492 Service Portal

Label words in the KM template are not correctly displayed in the Service Portal portal when 9.50
the browser language is set to Simplified Chinese or Portuguese (Brazil).

QCCR1D230825 Service Portal

The KM details page is displayed incorrectly in Service Portal.

9.50

QCCR1D231198 Service Portal

The "Description", "Name", and "Attachment" fields in request forms are not controlled by
the form of the catalog item in Service Portal or by SRC tailoring in Service Manager.

9.50

QCCR1E135706

Service Portal

Smart Search results contain duplicate entries in a Service Manager and Servicce Portal
integration if there is one or more replica servers.

9.50

QCCR1E135986

Smart
Analytics

Data is lost when IDOL performs a full index if the operator and the server are in different
time zones.

9.50

QCCR1E136724

Smart
Analytics

A RAD error occurs if you clear the Module name field when you add a Smart Ticket
configuration.

9.50

Global ID

Component

Service Portal

Workaround: Set the module name again.
QCCR1E136720

Smart
Analytics

The Document ID field in the Contact lib configuration is a contact name, which can be
modified by customers.

9.50

Workaround: Set the Document ID field another non-editable and unique field.

Service Manager (9.52)
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Global ID

Component

Issue

Introduced
in version

QCCR1E136304

Smart
Analytics

Global search cannot search some indexed meta data documents for attachments.

9.50

QCCR1E136067

Installation and
upgrade

The text strings "Change Category", "Change Task Category", "Problem Phase", and
"Interaction Status" are not localized on the Todo view.

9.50

Workaround: Set the display list and value list of the columns in the relevant forms
manually.
QCCR1E136563

Service
Manager
Survey

Survey can create interactions with inactive categories (such as complaint and
compliment).

9.50

QCCR1E136532

Applications

English text strings are displayed in the Knowledge Management-related records status list
for a linked svcCatalog.

9.50

QCCR1E135675

Service Portal

Service Manager Service Portal does not support Danish.

9.50

QCCR1E136563

Service
Manager
Survey

Survey can create interactions for inactive categories (for example, complaint and
compliment).

9.50

QCCR1D219352 Applications

After you enable the Solr plugin for Knowledge Article search in Service Portal, the Vote
and Leave comment buttons do not work when you view a KM article that originates from
Service Manager.

9.50

QCCR1E135768

When you try to link a new external type of knowledge by clicking Preview, the relationship
is not created.

9.50

Service
Manager
server

Workaround: Link the new external knowledge manually.
QCCR1E135137

Service
Manager
server

Service Manager (9.52)
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Global ID

Component

Issue

Introduced
in version

message is displayed.
Error Message: Error indexing document, bad attachment
Workaround: Add "eml" to the Skip these extensions field on the Type information
tab for the corresponding knowledgebase definition.
QCCR1E130699

Smart
Analytics

When you import HPIT KM data, a data length error occurs.

9.50

QCCR1E130700

Smart
Analytics

When you import HPIT KM data, categories that do not already exist in Service Manager
are not imported.

9.50

QCCR1E135647

Integration

If you have never logged in to the SAML SSO-enabled web client, Service Request
Catalog, or Mobility client, you cannot log in by using legacy LWSSO.

9.50

QCCR1H108511 Integration

When you log out of a non-HPE product that is directly authenticated via ADFS, you are not
logged out of HPE products that are authenticated via IDM.

9.50

QCCR1E132020

When FIPS mode is enabled (fipsmode:2 is specified in the sm.ini file), Service Manager
initialization might be slow in Linux/Unix environments. This issue is caused by a lack of
entropy (randomness) available on the system used for random number generation and can
commonly occur on systems that are not receiving much direct user input, such as virtual
machines.

9.41 and
patches

Performance

Workaround: You can direct the JVM to use /dev/urandom with the following
directive:
Add the following line to the Server's sm.ini file:
-Djava.security.egd=file:/dev/urandom
Alternatively, you can add the following line to the jre/lib/security/java.security file:
securerandom.source=file:/dev/urandom

Service Manager (9.52)
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Global ID

Component

Issue

Introduced
in version

For additional information, see the following important third-party information:
http://bugs.java.com/view_bug.do?bug_id=6521844
http://www.2uo.de/myths-about-urandom/
QCCR1E132194

Smart
Analytics

The ssl configuration topic of the Smart Analytics document is missing information to
9.41 and
configure level2proxy and image server. The information to configure the CFS server is also patches
incorrect.
Workaround: See the corrected configuration topic at:
How to configure TSL/SSL for two-way authentication between Service Manager and
Smart Analytics

QCCR1E130718

Mobility

When you rotate the screen of an iOS9-based device to landscape and then back to
portrait, the Mobility client page is incorrectly displayed.

9.41 and
patches

Workaround: Refresh the browser.
QCCR1E128546

Smart
Analytics

On a virtual machine with Interl(R) Core(TM)2 Duo CPU T7700 @2.40 Ghz, 2.59 GHz
(4Processors), a memory leak occurs on the http connector server.

9.41 and
patches

QCCR1E128412

Service
Manager
server

On Unix platforms, the legacy listener does not work if Service Manager server uses the
Oracle 12c instant client.

9.41 and
patches

QCCR1E124820

Service
Manager
server

After you add the "Service Display Name" field to a Change view and specify the "Service"
field as a group-by field, an error occurs and the view does not load when you sort the view
by Service Display Name.

9.41 and
patches

Workaround: Add either the “Service” field or the “Service Display Name” field to both
the view and the list of group-by fields.

Service Manager (9.52)
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Global ID

Component

Issue

Introduced
in version

Note that the “Service” field is preferred because this field is populated with CI Display
Name values. There is no need to add the second level field, Service Display Name.
QCCR1E127873

Applications

In the Service Manager (SM) Hybrid mode, calling the SM RESTful API for UCMDB
integration for the first time will fail.

9.41 and
patches

Workaround: Make a call to the API after you set up the SM Hybrid environment.
QCCR1E127858

Service
Manager
server

The index status is not updated into the Knowledge Management knowledge base, and
thus the library cannot be searched in the main search page and the context-aware page.

9.41 and
patches

Workaround: Drill down into the Knowledge Maintenance page for the library to
synchronize the index status into the Knowledge Management knowledge base.
QCCR1E127872

Smart
Analytics

The IDOL content service does not start on machines that have 24 CPU cores configured.

9.41 and
patches

Workaround: You can apply a workaround if the following error appears in the
application.log of the content server:
[1] 70-Error: Error: Attempt to open [ =…)0] failed. (No such file or
directory). The file open mode [rb] does not permit creation of a new
file.
In this case, modify the following parameters in the configuration of the content server,
and then restart the content server.
[Server] Threads=x [AsyncActions] Threads=y let x+y<32
QCCR1E127858

Smart
Analytics

The new library index status is not updated in the "kmknowledgebase" table when you click
Full Reindex in the Knowledge Maintentance page.

9.41 and
patches

Workaround: Refresh the status in library configuration.

Service Manager (9.52)
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Global ID

Component

Issue

Introduced
in version

QCCR1E127861

Applications

The logical.name of the CI is displayed on the "Edit OO flow" widget for Emergency
Change records in the "Build and Test" phase.

9.41 and
patches

QCCR1E126469

Web client

Chrome 44 refuses to send https requests to a web server with a self-signed SSL
certificate. Additionally, you receive the following error message:

9.41 and
patches

Failed to load resource: net::ERR_INSECURE_RESPONSE
Since all requests are blocked, the web server terminates the user session after a while and
the user is logged out.
Workaround: Use Chrome 43 instead.
QCCR1E124206

Service
Manager
survey

Service Manager survey does not support multiple companies.

9.41 and
patches

QCCR1E124149

Service
Manager
reports

Records that do not satisfy query conditions for selected lines are displayed in the
calculation chart report.

9.41 and
patches

QCCR1E124144

Service
Manager
reports

You cannot drill down into the calculation and duration charts when the aggregator is set to
MIN or MAX.

9.41 and
patches

QCCR1E124821

Web client

Auto-complete does not work when the link line of the associated field has the "Skip Query
Rewriting" option enabled.

9.41 and
patches

QCCR1E122174

Web client

SMC does not support RTL.

9.41 and
patches

QCCR1E124466

Smart
Analytics

Error messages displayed in English are not indexed in localized language versions.

9.41 and
patches

QCCR1E125500

Web client

If you enable the "preventDuplicatedAttachmentName" parameter in web.xml and then

9.41 and
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upload the same file twice, an error message is not displayed in the Internet Explorer and
Chrome browsers.

patches

QCCR1E126359

Smart
Analytics

English text in screenshots is not recognized correctly when your contact language is
Arabic.

9.41 and
patches

QCCR1E121838

Service
Manager
Reports

Labels overlap on Stacked Horizontal bar charts in Reports.

9.41 and
patches

QCCR1E122115

Service
Manager
Reports

Values less than 0 are not displayed correctly in bar or area charts.

9.41 and
patches

QCCR1E125879

Service
Manager
Reports

The additional Request Overview (PD) (Global) dashboard and its reports are displayed in
Classic mode.

9.41 and
patches

QCCR1E122716

Smart
Analytics

You cannot drill down into the index for fsylib.

9.41 and
patches

QCCR1E127170

Smart
Analytics

You cannot tailor OO flows.

9.41 and
patches

QCCR1E123090

Smart
Analytics

Special characters cannot be searched for in IDOL.

9.41 and
patches

QCCR1E123438

Smart
Analytics

An error message with an unclear meaning is displayed when the OMNI Group Server is
offline.

9.41 and
patches

QCCR1E124369

Smart
Analytics

Some returned results from external libraries are not highlighted.

9.41 and
patches

QCCR1E124633

Smart
Analytics

When you set all Index Weight values to “No Index” and then click Save, the configuration
is saved incorrectly.

9.41 and
patches
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QCCR1E126198

Smart
Analytics

The Smart Search Configuration tab is incorrectly named “environment: knowledge
management”.

9.41 and
patches

QCCR1E126737

Smart
Analytics

Links in the file system search results do not open in Firefox or Chrome.

9.41 and
patches

QCCR1E126780

Smart
Analytics

The pagination count is not correct in the main search page.

9.41 and
patches

QCCR1E126842

Smart
Analytics

The “Set parent” button in Smart Search should not be shown for non-Process Designerbased Incidents.

9.41 and
patches

QCCR1E126847

Smart
Analytics

The reported number of search results from the catalog library is not correct.

9.41 and
patches

QCCR1E126848

Smart
Analytics

SharePoint pages are indexed into IDOL incorrectly.

9.41 and
patches

QCCR1E126852

Smart
Analytics

Type ahead cannot use the display value of a global list in the advanced filter function in
Smart Search.

9.41 and
patches

QCCR1E126886

Smart
Analytics

The Change Service value does not display the CI Display Name.

9.41 and
patches

QCCR1E126901

Smart
Analytics

Preconditions should be merged if there are multiple preconditions for a file, but the criteria
conflict.

9.41 and
patches

QCCR1E126974

Smart
Analytics

The reported number of search results is incorrect.

9.41 and
patches

QCCR1E126978

Smart
Analytics

You cannot select the ID-title in Smart Search in Internet Explorer 10.

9.41 and
patches

QCCR1E127031

Smart
Analytics

No error message is displayed in the library if the attachment is not indexed successfully.

9.41 and
patches
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QCCR1E127368

Smart
Analytics

If you use fields that are not in the form in the match criteria of a predefined filter in Smart
Search, Smart Search does not work.

9.41 and
patches

Workaround: Add the fields used in the match criteria of the predefined filter in
context aware search into the form of the current working ticket.
QCCR1E124715

Smart
Analytics

You cannot connect to IDOL with an IPv6 address.

9.41 and
patches

QCCR1E124520

Smart
Analytics

On a tablet, the back and forward buttons do not work correctly in IDOL external webpage
details pages.

9.41 and
patches

QCCR1E125084

Smart
Analytics

The number of search results changes after you click to view the next page.

9.41 and
patches

QCCR1E126163

Service
Manager
server

In the HS environment, locked sessions cannot be killed from the Show Locks format
(system.status.locks.g).

9.41 and
patches

QCCR1E125549

Service
Manager
server

If there is 127.0.0.1 in the hosts file, the hostname is displayed as "localhost.localdomain"
in the result of the command "sm -reportlbstatus".

9.41 and
patches

QCCR1E127029

Service
Request
Catalog

The average response time of the "src01_02_search" transaction is more than 2s in 9.41,
compared to that of 0.8s in the previous release.

9.41 and
patches

QCCR1E125884

Smart
Analytics

The old Knowlege Management search icon is still displayed.

9.41 and
patches

QCCR1E127213

Smart
Analytics

The "Content1" service cannot be started by the "Start Service" function in the IDOL
installer.

9.41 and
patches

QCCR1E121838

Service

In the "Stacked Horizontal bar" report, the value label is truncated.

9.41 and
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Manager
Reports
QCCR1E122716

Smart
Analytics

Introduced
in version
patches

Users cannot drill down into index for fsylib links.

9.41 and
patches

Workaround: The fsyslib link refers to URLs with the "file://" protocol in search
results. However, Firefox and Chrome do not open such links when they are clicked in
the result page or in the pages that are originated from outside the local machine. This
is a design decision made by those browsers to improve security. Internet Explorer
supports this functionality by default.
QCCR1E123433

Applications

The display name is not displayed in the mass update interface. Instead, only the logical
name is displayed.

9.41 and
patches

QCCR1E120454

Applications

The datadict record cannot be saved when the display name is changed.

9.41 and
patches

QCCR1E127326

Integrations

UCMDB federation is blocked.

9.41 and
patches

QCCR1E122190

Applications

If you set a fuzzy search condition before, the comfill box that has the reference table
setting on displays an empty list.

9.41 and
patches

QCCR1E119964

Applications

When a new record is added in dbdict, the alias of type is not removed and the alias for
display.name is not created.

9.41 and
patches

QCCR1E120414

Service
Manager
server

Service Manager does not reference a function if the field is a variable.

9.41 and
patches

QCCR1E121852

Windows client The Fill button does not work if the values of the "diaplay list" and "value list" are set in
Windows client.

9.41 and
patches

QCCR1E122160

Applications

9.41 and
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patches

QCCR1E123135

Applications

The CI Display Name is not displayed on the "Asset Allocation" form.

9.41 and
patches

QCCR1E123311

Web client

An "No Record Found" error is displayed when characters are deleted from the end of the
value filled by the auto complete functionality.

9.41 and
patches

QCCR1E123536

Applications

The logical.name of the CI is displayed for the "Create Template from Record" interface of
an incident record.

9.41 and
patches

QCCR1E123716

Web client

The order is not correct for CI Name in the pivot table.

9.41 and
patches

QCCR1E124360

Web client

A tab cannot be closed in the dialog mode.

9.41 and
patches

QCCR1E124423

Applications

Reference cannot be set on the member of an array of a structure.

9.41 and
patches

QCCR1E125032

Web client

The style of the popup window is lost when the session is refreshed.

9.41 and
patches

QCCR1E125204

Applications

When the Affected CI in the cross table is exported as a list, the logical name is displayed.

9.41 and
patches

QCCR1E126003

Applications

No validation is done when you input an invalid CI in a service level target.

9.41 and
patches

QCCR1E126006

Applications

The logical name of a CI is displayed in the "Additional Properties" tab in a Request task.

9.41 and
patches

QCCR1E127712

Web client

An "invalid CI" error message is displayed when you select the CI through the auto
complete functionality.

9.41 and
patches
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QCCR1E121670

Service
Manager
server

The value of the comfill control is not restored if it is an array list in the change record.

9.41 and
patches

QCCR1E127303

Web client

Chinese characters sent from Lync are displayed as "????" in Service Manager
Collaboration.

9.41 and
patches

QCCR1E127732

Mobility

The page is hung after you fill the incident subcategory in Chrome (version 44) on Android.

9.41 and
patches

Workaround: Refresh the page in this case, and the list will be displayed. You can
then select an item and save the record successfully.
QCCR1E128218

Applications

When you are adding/modifying CI relationships, the following Relationship Type values
are available for selection: Accesses, Aggregation, ClientServer, Composition, and so
on, (which are correct values). However, when you are viewing CI relationships in the CI
detail form, you can select only the following Relationship Type values as a filter: All,
Logical, and Physical (which are no longer used in Service Manager 9.41).

9.41 and
patches

QCCR1E126631

Process
Designer

When you select a value for a task category in the task planner two times, only one value is
available the second time.

9.41 and
patches

Workaround: To see all list items, clean the combo field and click the drop-down
button again.
QCCR1E126641

Smart
Analytics

Related record information for Phase, Status, and Title in the Interaction details page is not
displayed until you exit the related Incident session.

9.41 and
patches

QCCR1E124819

Install and
upgrade

After an upgrade to 9.40, some users cannot see the inboxes.

9.40 and
patches

Tip: To solve this issues, do the following after the upgrade:
Step 1. Mass unload the inboxes.
1. Type "db" in the command line, and press Enter to open the Database Manager.
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2. Enter "inbox" in the Table field, and then click Search.
3. Double-click "inbox.view" from the list that is displayed.
4. Click Search to display all inboxes.
5. Click "Mass Unload" from the record list pane.
6. Follow the wizard to export all inbox records to an unload file.
Step 2. Remove all inboxes
1. Type "db" in the command line, and press Enter to open the Database Manager.
2. Select the Administration mode check box.
3. Enter "inbox" in the Table field, and then click Search.
4. Double-click "inbox.view" from the list that is displayed.
5. Click Search to display all inboxes.
6. Click Mass Delete to delete all inboxes.
Step 3. Load the exported inboxes back to SM
1. Type "db" in the command line, and press Enter to open the Database Manager.
2. Right-click the window, and then select Import/Load.
3. In the File Name field, browse to the unload file that you created previously.
4. Click Load FG to load the inbox records.
QCCR1E127857

Install and
upgrade

An error that indicates the query field "pd.enabled" in "upginfo" is not defined in "dbdict" is
generated when smupgrade is invoked.

9.41 and
patches

Workaround: Purge data and reload preupg.bin again after preupg.bin is loaded for the
first time.
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QCCR1E121160

Service
Manager
server

The HPE Legacy listener does not connect to the Service Manager database after the
primary key feature is enabled.

9.40 and
patches

Workaround:
1. Make the following changes to the SQLServer SQL:
ALTER TABLE [932].[dbo].[OPERATORM1]
ADD RECORD_KEY varchar(60) NOT NULL DEFAULT('a')
ALTER TABLE [932].[dbo].[OPERATORA1]
ADD RECORD_KEY varchar(60) NOT NULL DEFAULT('a')
...
ALTER TABLE [932].[dbo].[OPERATORA5]
ADD RECORD_KEY varchar(60) NOT NULL DEFAULT('a')
UPDATE [932].[dbo].[OPERATORM1]
set
[RECORD_KEY] = [NAME]
UPDATE [932].[dbo].[OPERATORA1]
set
[RECORD_KEY] = [NAME]
...
UPDATE [932].[dbo].[OPERATORA5]
set
[RECORD_KEY] = [NAME]
2. Log on to Service Manager, open the Operator dbdict, and then import this new
column.
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3. Add this new column as the unique key.
QCCR1E135225

Service
Manager
server

Crystal Reports cannot access Request data by using sc_report_odbc.

QCCR1E118066

Service
Truncation and overlapping of elements on the details page of the Missing Reference
Manager studio Report occurs when you use the vertical view.

9.40 and
patches

9.40 and
patches

Workaround: Resize the details page to make it wider or use the horizontal layout.
QCCR1E117293

Service
When you rebuild relationships in Relationship Manager, link type relationships that have a
Manager studio "fixed" status are removed.

9.40 and
patches

QCCR1E115272

Service
ERDs cannot be recovered when you open another tab in the same browser.
Manager studio

9.40 and
patches

QCCR1E93098

Applications

9.40 and
patches

When you modify a problem record, and then try to close the record whilst a backend
process modifies the record at the same time, you are prompted with a message that asks
you to merge the conflict.
However, after the record is merged, you cannot close the problem record.

QCCR1E118260

Applications

When you search for an incident, interaction, or change in a heavily-populated database,
the operation takes more than 20 seconds.

9.40 and
patches

Workaround: Change the first unique key to the primary key for the modules that
have this issue.
QCCR1E116869

Service
Manager
server

Service Manager (9.52)

The primary key is lost after you change the length of a field in a dbdict.

9.40 and
patches

Workaround: Manually recreate the primary key.
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QCCR1E112005

Service
Manager
server

Due to a limitation in Oracle 11g, records in the patchrelresults and scmessage tables that
have a Primary Key cannot be unloaded correctly in an Oracle 11g database.

9.40 and
patches

Workaround: Change the Primary Key of the patchrelresults and scmessage tables
to a Unique Key before you perform the unload.
QCCR1E111068

Process
Designer

When you click a Change model in the navigation tree in Firefox, a TypeError occurs.

9.40 and
patches

Workaround: Use Internet Explorer or Chrome.
QCCR1E112202

Process
Designer

When a workflow description tooltip contains too many lines, the background color is
incorrectly displayed as white.

9.40 and
patches

QCCR1E113131

Process
Designer

When you save a record for which an additional form is configured, the display returns to
the primary form.

9.40 and
patches

QCCR1E115310

Process
Designer

Hotkeys are not supported for menu items in the workflows page.

9.40 and
patches

QCCR1E115608

Process
Designer

You cannot modify the option ID of workflow-based actions, and an option ID that
duplicates an ID in display options may be generated.

9.40 and
patches

Workaround: Manually change the display option ID.
QCCR1E115772

Process
Designer

In Internet Explorer, the workflow viewer may unexpectedly scroll right or down if you have
a scroll bar and the browser zooms in.

9.40 and
patches

QCCR1E115828

Process
Designer

You cannot expand or collapse the workflow list folder by using the Space key. This
behavior is therefore not consistent with accesibility behaviour in the standard client.

9.40 and
patches

QCCR1E116043

Process
Designer

The workflow viewer moves to next phase incorrectly when an automatic transition is
blocked by an unclosed task.

9.40 and
patches
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Workaround: Reload the record.
QCCR1E116343

Process
Designer

The query editor may be launched with an incorrect query record table name.

9.40 and
patches

QCCR1E116937

Process
Designer

Requests that have an open request task cannot transition to the next phase, but activities
can be saved.

9.40 and
patches

QCCR1E117154

Process
Designer

There is no reminder to users that they must set the table name of a rule set in order to
populate the "Group Field Name" and "Service Field Name" drop-down lists in the
Assignment rule configuration form.

9.40 and
patches

QCCR1E117366

Process
Designer

The User Option condition does not work correctly when the option value is an array type.

9.40 and
patches

Workaround: In Condition Editor, set the value of User Option UO1 = {"1"} instead of
User Option UO1 = "1"
QCCR1E118589

Process
Designer

If you use the task editor to edit a task in a change model, and then try to save the change
model, you receive a "The record being updated has been modified since read" error
message.

9.40 and
patches

Workaround: Close the current change model and open it again to update the
changes in the change model other than the task editor changes.

QCCR1E118741

Process
Designer

Inconsistencies can occur between Change categories and "Open in Phase'/'Close by
Phase" tasks in change models.

9.40 and
patches

Workaround: Manually update the "Open in Phase" and "Close by Phase" in Task
Planner.
QCCR1E117551

Installation and

Service Manager (9.52)
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upgrade

Invalid object name 'CM3RM2'

patches

Note: Ignore this error if CM3RM2 is created after the upgrade.
QCCR1E117439

Mobile client

The chm.cm3r.release.mobile form retrieves members from the "COORDINATOR" group
as the Change Coordinator values. However, the current data source table is "cm3groups,"
which is for Service Manager Classic.

9.40 and
patches

Workaround: Use the "assignment" table instead of the "cm3groups" table in Service
Manager Codeless.
QCCR1E103336

Mobile client

There is no split line between the Updates tab and the Approval tab in an Emergency
Change record when you use the Google Chrome browser for Android.

9.40 and
patches

QCCR1E117328

Mobile client

A Reject Reason is filed in the retraction page with an empty Reject Reason option.

9.40 and
patches

QCCR1E117598

Mobile client

The Array comfill is displayed as a black block when you use the Mobile Applications in the
self-service user view.

9.40 and
patches

QCCR1E115349

Mobile client

Items in the "My open Requests" and "My Closed Requests" lists are not displayed in the
correct order. The latest request to be created does not appear at the top.

9.40 and
patches

QCCR1E118626

Mobile client

Pictures attached to interactions are not saved to the local gallery in IOS 8.1.1.

9.40 and
patches

Workaround: Use the Chrome browser instead of Safari.
QCCR1E118215

Smart
Analytics

The Distributed Image Server does not support large size images (over 1MB) in concurrent
user testing.

9.40 and
patches

QCCR1E118907

Smart
Analytics

Hot Topic Analytics does not support accessibility as expected.

9.40 and
patches

QCCR1E113455

Service

The remote path and mapping path cannot be set in the File Server Base Path if you do not

9.40 and
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Manager
Reports

start Service Manager with administrative privelages.

patches

Workaround: Start Service Manager as an administrator.
QCCR1E109588

Service
Manager
Reports

List reports cannot retrieve data from replicated databases.

9.40 and
patches

QCCR1E110835

Service
Manager
Reports

Reports that have long legend text do not print as expected.

9.40 and
patches

QCCR1E105868

Service
Manager
Reports

Service Manager loads reports in a dashboard one-by-one.

9.40 and
patches

QCCR1E105815

Service
Manager
Reports

Service Manager server CPU utilization is higher than expected when the ToDo queue is
set as the landing page and the inbox size exceeds 50K.

9.40 and
patches

Workaround: Shorten the legend label.

Workaround: Check the inbox size periodically, and control the size manually.
QCCR1E109576

Service
Manager
Reports

When you export a report from the webtier, the report data and definition are fetched from
server. Therefore, the exported and on-screen reports may differ if you have modified the
report data but not refreshed the screen.

9.40 and
patches

Workaround: Refresh the dashboard before exporting a report.
QCCR1E118434

Service
Manager
Reports

The temp file in the Tomcat temp directory cannot be deleted after the session is closed.

9.40 and
patches

QCCR1E106640

Service
Manager

Query conditions in the condition box and condition builder are not consistent.

9.40 and
patches
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The JVM heap size for the report.export thread needs to be at least 1024MB when the
export threads are configured to 10.

9.40 and
patches

Reports
QCCR1E118269

Service
Manager
Reports

Workaround: Set a dedicated Service Manager instance for the reporting schedule.
QCCR1E111234

Service
Manager
Reports

You can export reports as a PDF only in the system language font.

9.40 and
patches

QCCR1E117603

Service
Manager
Reports

The meaning of the text string "inbox" is not always clear.

9.40 and
patches

QCCR1E118983

Applications

If your SQL Server database uses Unicode with a collation that does not support a specific
language (for example, Latin1_General_100_BIN, which does not support Chinese), when
you create an HTML Template with a name containing text in that language, save the
template and open the template again by performing a search, the template name is
displayed incorrectly – characters in that language are displayed as unrecognizable text.

9.40 and
patches

Workaround: Click Tailoring > Database Dictionary, search for "htmltemplates,"
click the htmlcode field, and then change the SQL RC value to "true."
QCCR1E119106

Applications

If your SQL Server database uses Unicode with a collation that does not support a specific
language (for example, Latin1_General_100_BIN, which does not support Chinese), when
you create a knowledge document whose title contains characters in the unsupported
language, the document is displayed correctly. However, if you search in the Knowledge
Library using keywords from the document, the document is returned in the search results
with characters in that language displayed as unrecognizable text.

9.40 and
patches

Workaround: Click Tailoring > Database Dictionary, search for
"kmknowledgebaseupdates,"click the recdata field, and then change the SQL RC
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value to "True."
If you already have garbled data in your search results, perform a full index against that
library.
QCCR1E89819

Applications

The "Request TCAB Approval" step in the Normal Change workflow takes more than 100
seconds to complete when there are 6000 users in the database.

9.40 and
patches

Workaround: Modify the "operator" dbdict manually to fix this issue. First, create a
new "a6" table in the SQL Tables tab. Then, modify the value of the "secRole" field
from "m1" to "a6" in the Fields tab for both fields (array field and child field).
QCCR1E117326

Applications

The total cost of a Request, Incident, Problem, Change, or task record is recalculated when 9.40 and
you update the cost information. Therefore, when you update an operator’s hourly rate, the
patches
historical cost of the record (that is, cost that is already incurred) may also be updated
incorrectly.

QCCR1E118616

Applications

The Create One Request Fulfillment Record for each Device of Class X at location Y 9.40 and
effect option in Scheduled Maintenance does not work correctly.
patches

QCCR1E114145

Applications

If two items in a bundle have the same user option name, only the last user option can be
referenced by the system for evaluation.

9.40 and
patches

Workaround: Do not use duplicate user options for items in one service catalog
bundle.
QCCR1E117903

Applications

Service Manager (9.52)

When you cancel a planned purchase task before you finish creating it, validation of the
task still occurs.

9.40 and
patches

Page 37 of 68

Installation notes
This section provides instructions for installing each component in this patch release.
Before you proceed, we recommend that you consult the latest Service Manager 9.52 Support Matrix.
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Backup and backout instructions
In case you need to restore your Service Manager system to its original state after installing the
component patches in this release, make necessary backups before each patch installation. If a
rollback is needed, follow the backout instructions.

Applications
This release does not contain an applications or upgrade package. The latest applications version is
9.52. An applications upgrade is optional if your application version is 9.34 or later. If you plan to
upgrade your applications to 9.52, make a backup of your database before the upgrade in case you
need to restore your database after the upgrade. Creating a backup of the entire database and restoring
the database if needed is the best approach for a full applications upgrade. You can install the Service
Manager 9.52 applications or upgrade package according to your current applications version. You can
find the SM 9.52 Applications or Upgrade package as well as Service Manager9.52 Release Notes in
the Service Manager 9.52 installation media.
If you plan to load individual unload files in this release, follow the backup and backout instructions
below.

Backup
Tip: Service Manager 9.52 only supports application versions 9.34 and later. If your application is
version 9.34 or later, we recommend that you use Unload Manager to make a backup of the files
that will be modified by an unload file, because Unload Manager can create a backup of your old
data during the installation of the unload; you can also use Database Manager to backup the files
instead. If your application version is not supported, please upgrade your applications to a
supported version.
To use Unload Manager to make a backup, follow these steps:
1. Go to System Administration > Ongoing Maintenance > Unload Manager.
2. Double-click Apply Unload to open the wizard.
3. Select the unload file you want to apply, also specify a backup file, and then click Next. Details of
the unload file appear.
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4. Double-click a conflicting object in the table to open the merge tool:
a. Merge the object, and then select the Reconciled check box.
b. Click Save to go back to the wizard.
5. Click Next after all the conflicting objects are reconciled.
6. Click Yes on the confirmation window to apply the unload.
7. Click Finish.
Now, the unload has been applied and at the same time your old data backed up.
To use Database Manager to make a backup, follow these steps:
1. Go to Database Manager, select Import/Load from More or the More Actions menu, and browse
to the unload file.
2. Click List Contents on the menu bar to view a list of files that have been updated in this unload.
See the following figure for an example.

This figure shows the contents of an unload file that contains changes to the following files.
File

Record

Process

svc.add.cart

application

money.format
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File

Record
Note: The scmessage records listed under each RAD application are
messages used in this RAD application; no backup is needed for them.

ScriptLibrary

svcCartHelper

datadict

activity

dbdict

activity
Note: The “activity” file with no records actually represents the dbdict
record of the activity file.

scmessage

The record whose message class is “fc” and message number is 1000.

3. Go to Database Manager, in the Table field enter a file name you got in step 2, and click the
Search button.
4. If the format selection page shows, select the proper format by double-clicking it (for example,
select the device format for the device file), and then search for the file record.
5. Click More (or the More Actions menu) > Export/Unload after the file record is displayed.
Note: If Export/Unload is not available, check the Administration Mode check box in
Database Manager and try again.
6. In the pop-up window, specify your backup upload file path/name, and click Unload Appl.
Caution: Make sure that Append to file is selected.
7. Repeat steps 3 through 6 to back up the rest of the files you got in step 2.

Backout
Tip: You can use Unload Manager (recommended) or Database Manager (if Unload Manager is
not available in your application version) to roll back to your old data, as described in the following
instructions.
To roll back to your old data using Unload Manager, follow these steps:
1. Go to System Administration > Ongoing Maintenance > Unload Manager.
2. Double-click Apply Unload to open the wizard.
3. Select the unload file generated in the backup process, specify a backup file, and then click Next.
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Details of the unload file are displayed.
4. Double-click a conflicting object in the table to open the merge tool:
a. Merge the object, and then select the Reconciled check box.
b. Click Save to return to the wizard.
5. Click Next after all the conflicting objects are reconciled.
6. Click Yes on the confirmation window to apply the backup unload.
7. Click Finish.
To roll back to your old data using Database Manager, follow these steps:
1. Go to Database Manager, click More > Import/Load.
2. Browse to the backup unload file you created.
3. Click Load FG.

Server
Backup
Before you apply the server patch, make a backup of the server installation folder (for example,
C:\Program Files\HPE\Service Manager 9.52\Server). If you have used the Windows or Linux
PatchSetup tool to install the current server patch, a backup is already made by the tool.
Note: If you have a horizontally-scaled system, you must back up the server installation folder for
each server instance.
Service Manager has supported FIPS mode since version 9.32. To run Service Manager in FIPS mode,
you must upgrade your database to the 256-bit AES encryption algorithm. Once you change all of the
encrypted fields to use the new 32 character encryption you cannot roll back the RTE and still read the
encrypted data.

Backout
Follow these steps to back out the installation:
1. Stop the Service Manager server.
2. Execute the PatchUninstall.bat on Windows or PatchUninstall.sh on Linux (the file is located in
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the <SM Installation> directory).
Note: You can only use the server patch uninstallation tool if you have applied the current
patch by using the server patch installation tool. Furthermore, you can only use the tool to
restore a version that was backed up by the server patch installation tool.
3. When prompted, enter the full path of the Service Manager server backup directory. A list of the
available backups is displayed.
4. Select the desired backup version and confirm your selection.
Note: If you have a horizontally-scaled system, make sure that every server instance is
replaced with its backup.
5. If you have also loaded platform unload files required for your server changes, you must also roll
back the application changes made by the unload files. See "Applications" on page 39.
6. Restart the Service Manager server.
If the tool fails to back out the server patch, the details are recorded in the PatchUninstall.log file.
Note: If you cannot use the tool to back out your Linux or Windows-based Service Manager
server, follow these manual steps instead:
1. Stop the Service Manager server.
2. Remove the existing server installation folder.
3. Copy the backup folder back.
Note: Make sure that the embedded Tomcat is also replaced with the backup, because
the version of the embedded Tomcat may have dependency on a specific server version.
Note: If you have a horizontally-scaled system, make sure that every server instance is
replaced with its backup.
4. If you have also loaded platform unload files required for your server changes, you must also
roll back the application changes made by the unload files. See "Applications" on page 39.
5. Restart the Service Manager server.
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Web tier
Backup
Before you deploy the new web tier, back up the following items:
l

lwssofmconf.xml

l

web.xml file

l

application-context.xml

l

log4j.properties

l

splash screen

l

style sheets

l

The folder that is defined in the customize-folder parameter in the web.xml file

l

<webtier>\images\obj16\ folder

l

Any other customizations that you made, including your webtier-<version>.war (webtier-ear<version>.ear) file.

Backout
To roll back to the old web tier, follow these steps:
1. Delete or uninstall the existing web tier.
2. Clear the cache of your web application server (for example, Tomcat).
3. Redeploy the old web tier.
4. Restore your old customizations.

Windows client
Backup
1. Make a backup of your Windows client home folder. For example,
C:\Users\<username>\ServiceManager. Your connections and personalized settings are stored
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in this folder.
Note: This is the out-of-the-box home directory, and could differ from yours if you made
changes to <Client>\configuration\config.ini file. If so, back up the files from the
location specified in that file.
2. Make a backup of your certificate configuration files if any (Window > Preferences > HP Service
Manager > Security). For example, your CA certificates file and client keystore file.
3. Make a backup of the following folder:
<Client>\plugins\com.hp.ov.sm.client.eclipse.user_
x.xx.xxxx\src\resources\icons\obj16\.

Backout
1. Uninstall the new Windows client.
2. Reinstall the previous Windows client.
3. Restore your old Windows connections and configurations.

SRC
Backup
Before deploying new SRC war package, back up the following files if they have been customized:
l

WEB-INF/classes/applicationcontext.properties

l

WEB-INF/classes/lwssofmconf.xml

l

WEB-INF/classes/cacConfiguration.properties

l

WEB-INF/web.xml

l

Custom.properties

l

secure/configuration folder

Backout
To roll back to the old SRC, follow these steps:
1. Delete or uninstall the existing SRC.
2. Clear the cache of your web application server.
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3. Redeploy the old SRC war package.
4. Restore your old customizations.

Solr Search Engine
To back out your Solr search engine changes, make a backup before your KM patch installation.
Note: Keep in mind that you also need to roll back KM-related server side and application side
changes. For details, see the Server and Application backup and backout Instructions.

Backup
Before installing the KM patch component and upgrading the JDK and KM-embedded Tomcat, perform
the following tasks:
l

Make a backup of the search engine installation folder. For example, C:\Program
Files\HPE\Service Manager 9.52\Search Engine Backup

l

Make a backup of the files to be modified by the unload files in the KM patch.

l

Make a backup of your schemastub.xml file under directory <SM server>/RUN/km/styles/.

Backout
After installing the KM patch, follow these steps:
1. Stop your Solr search engine.
2. On Windows: at the Windows command line, run the following command to remove the old KM
Search engine windows service:
installasservice.cmd remove [nodetype]
Note: In this command, [nodetype] is a placeholder for "master" or "slave", depending on
whether the KM Search engine server is the master or a slave.
3. Remove the existing search engine installation folder.
4. Copy the backup folder back.
5. Rollback the previous JDK installation and change the JAVA_HOME environment variable back.
6. Be sure to roll back KM related changes on the Service Manager server and application sides,
including the kmsolr unloads files and the server's schemastub file.
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7. On Windows: at the Windows command line, run the following command to install the old KM
Search engine windows service:
installasservice.cmd install [nodetype]
Note: In this command, [nodetype] is a placeholder for "master" or "slave", depending on
whether the KM Search engine server is the master or a slave.
8. Restart your Solr search engine.
9. Perform a full re-indexing on all of your knowledgebases.

SM Collaboration
Backup
Before you deploy the new Openfire chat server, perform the following steps:
1. Stop your existing Openfire.
2. Rename the existing Openfire folder.
3. Make a backup of the following items:
o

<Openfire_Home>\conf\crowd.properties

o

<Openfire_Home>\conf\openfire.xml

o

<Openfire_Home>\conf\security.xml

o

<Openfire_Home>\plugins\lwssoplugin\lwssofmconf.xml

o

<Openfire_Home>\lib\ojdbc-xxxx.jar (the JDBC driver if you copied it to this folder before)

o

Any other customizations that you made

Backout
If you want to roll back after you deploy the new version, perform the following steps:
1. Remove the new Openfire installation folder.
2. Restore the renamed Openfire folder.
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Digital signature notice
HPE signs Windows executable files with a digital signature. Since January 2012, this process has
been updated to use a new VeriSign root certificate. On a Windows system that does not have the new
VeriSign root or intermediate certificate installed, when the user right-clicks the file and then goes to
Properties > Digital Signatures > Details, the following verification error is displayed:
The certificate in this signature cannot be verified.

To resolve this issue, either enable Windows Update or download and install the G5 Root certificate
from the How to install the 2048-bit Code Signing root and intermediate CA certificates? article:
https://knowledge.symantec.com/support/ssl-certificatessupport/index?page=content&id=SO19140&actp=search&viewlocale=en_US
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Regenerate Java certificates
The Service Manager server no longer accepts Java certificates that are generated by using certain
"weak" algorithms. If you used these algorithms to generate your Java certificates, you must now
regenerate them by using a more complex algorithm, such as RSA.
Note: We strongly recommend that you regenerate the Java certificates by using a more complex
algorithm. If it is not practical to do so, you can disable this enhancement. However, disabling this
enhancement lowers the security profile of Service Manager and you are not adhering to the known
security best practices.
Follow these steps to disable this enhancement:
1. Open the extra.java.security file that is located in the RUN folder.
2. Comment out or delete the contents of the file.
3. Restart the Service Manager server.
Alternatively, you can re-enable the acceptance of specific algorithms. For more information about
the security best practices for enabling the secure algorithms, refer to
https://wiki.mozilla.org/Security/Server_Side_TLS. Note that disabling certain algorithms may
cause connectivity issues between Service Manager and third-party web service clients. Micro
Focus recommends thorough connectivity testing after you update this file.
The following algorithms are no longer accepted:
l

MD5

l

DSA

l

3DES_EDE

l

DES_CBC

l

DHE, RC4

l

SSLv3

l

TLSv1

l

ECDH_anon

l

DH_anon

l

NULL
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l

DH keySize < 768

l

RSA keySize < 2048

Applications update installation
This release does not contain an applications or upgrade package. The latest applications version is
9.52. An applications upgrade is optional, and you can install the Service Manager 9.52 Applications or
upgrade package according to your current applications version.
You can find the the download links for SM 9.52 Applications or Upgrade package as well as Service
Manager 9.52 Release Notes from the Overview of Service Manager 9.5x Releases knowledge
document.

Server update installation
The server update for your operating system consists of a compressed file, sm9.52.6008-P6_<OS>.zip
(or .tar), which contains updated files of the Service Manager server. These files add to or replace the
files in the [SM Server Root]\([SM Server Root]/)RUN, irlang, bin, legacyintegration, and platform_
unloads directories.
Note: If you use an Oracle RDBMS, be aware that Oracle Call Interface (OCI) 11.2.0.3 or later is
required for Service Manager. For more information, see the latest Service Manager 9.52 Support
Matrix at https://softwaresupport.hp.com/group/softwaresupport/support-matrices

Built-in troubleshooting tool (SM Doctor)
The server patch will install the Service Manager Doctor (SM Doctor) tool in the <SM server root>\
(<SMserver root>/)smdoctor directory. For information on how to use this tool, see Troubleshoot >
Service Manager Doctor section in the Help Center.

Upgrade paths
This server patch must be applied on top of an earlier Service Manager 9.5x system.
The following server upgrade paths are recommended:
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l

New customers: Install the Service Manager 9.50 GA server, and then apply this server patch.

l

Existing Service Manager 9.3x/9.4x customers: Uninstall the old server, install the Service
Manager 9.50 GA server, and then apply this server patch.

l

Existing Service Manager 9.5x customers: Apply this server patch.

For installation instructions for the Service Manager 9.50 server, see Install the Service Manager
Server in Service Manager9.52 Help Center.

JRE upgrade
On Windows-based platforms, the server's embedded JRE is automatically upgraded to Azul Zulu 32bit OpenJDK version 1.8.0_181 after you apply the server patch. No manual tasks are necessary on
Windows-based platforms.
On Linux-based platforms, there are some additional tasks for this JRE upgrade after you apply the
server patch. To use the embedded Azul Zulu 32-bit OpenJDK on Linux-based platforms, follow these
steps:
1. Navigate to the Server's RUN directory.
2. Run the removeLinks.sh command, and then run the setupLinks.sh jre
command as the owner of the Service Manager installation directory. The system displays the
JRE found in RUN folder, no need to create symbolic link. message.
To use an Oracle JRE, manually download and install Oracle JRE 8.
For more information, see the JRE support section of the Deployment architecture topic in Service
Manager 9.52 Help Center.
Before you proceed, pay attention to the following issues.

Preventing failure of external web service calls over SSL
The JRE upgrade will cause external web service calls over SSL to fail if the remote endpoint does not
support Server Name Indication (SNI), which is by default activated in JRE 8. Once Service Manager
is upgraded to use JRE 8, it starts to use SNI extensions during the SSL handshake. If the remote
endpoint does not support SNI, the web service call will fail with an error message.
To solve this issue, do either of the following:
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l

Activate SNI at the remote end point (recommended)

l

If the remote endpoint does not support SNI extensions, SNI cannot be activated. In this case, add
the following JVMOption<n> parameter either to the sm.ini file, or to the start command of the
servlet(s) in the sm.cfg file:
JVMOption2:-Djsse.enableSNIExtension=false (in sm.ini)
sm -JVMOption2:-Djsse.enableSNIExtension=false (in sm.cfg)

Running the server on Linux with JRE 8
If you are using a horizontal implementation on Linux, after you upgrade the server, you may not be able
to kill a locked session from the Show Locks format (system.status.locks.g). This issue occurs only
when JRE 8 is used and only on certain Linux versions.
If it occurs, perform the following steps for the hosts file of each server to the solve the issue:
1. Open the hosts file of your server host (/etc/hosts).
2. Comment out the following line: 127.0.0.1 localhost
That is, change the line to the following: #127.0.0.1 localhost
3. Make sure the hosts file specifies only one host name for your server's IP.
4. Repeat the steps above for the rest of the server hosts.

Server patch installation steps
Caution:
l

The server patch will upgrade your embedded Tomcat to version 8.5.42, and therefore requires
additional steps.

l

The server patch will upgrade your JGroups (in the RUN/lib directory) to version 3.2.

Note: If you have a horizontally-scaled system, you must upgrade all your server instances.
To install the new server patch, follow these steps:
1. Stop all Service Manager clients.
2. Stop the Service Manager server.
3. Execute the PatchSetup.bat on Windows or PatchSetup.sh on Linux (the file is located in the
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patch directory).
4. When prompted, enter the full path of the current Service Manager server installation directory and
the full path of the Service Manager server backup directory.
5. If you have made any customizations/changes to the original RUN/tomcat folder, restore them in
the new RUN/tomcat folder.
6. Your old schemastub.xml file (in the <SM_Server_Home>\RUN\km\styles\ directory) has been
updated to a newer version. Either keep your old file by copying it back or keep the updated
version (a full reindex for the knowledgebases is then required).
7. Run the sm -unlockdatabase command.
Note: This step is required the first time you upgrade to 9.30p4 or later; it is also required
whenever you change the server’s IP address after your upgrade to 9.30p4 or later. The
purpose of this step is to prevent stale license information from being kept in the system. In a
scaling implementation, you can run this command from any one of your servers.
8. Restart the Service Manager server.
9. Restart the Service Manager clients.
10. Verify the version using either of the following methods:
o

From the Windows client, click Help > About Service Manager Server. The server version
should be:
Release9.52.6008build P6

o

From the server's RUN folder, run the sm -version command. The server version should be:
Version: 9.52.6008
Patch Level: P6

If the tool fails to install the server patch, the details are recorded in the PatchSetup.log file.

Server application unload installation
Note: All unload files in the server’s platform_unloads directory in this release have been already
merged into Service Manager applications 9.52. These files are provided just in case you do not
plan to upgrade to applications 9.52 while still want to take advantage of the relevant new features
or fixes. Unload files included in this release are for Service Manager 9.34, 9.35, and
9.4xapplications, because the server and clients in this release do not support applications
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versions earlier than 9.3x. For the specific applications version to which each unload applies, see
the "Applicable applications version" column in the following table.

Unload Files Included in the current patch
This release includes the following unload files.

Unload

Applicable
applications
version
Description

QCCR1E152483_ 9.34, 9.35,
SM952P6_
9.40, 9.41,
SM934.unl
9.50, 9.51,
and 9.52

Improves the RESTful performance when using the start
parameter to iterate a large table.

QCCR1E148685_ 9.52
SM952P4_
SM952.unl

Fixes an issue in which create problem and create change do
not work for Hot Topic Analytics in the Incident module.
Note: You need to apply this unload file only if you have
applied the QCCR1E141792_SM952P3_SM952.unl file in
SM9.52p3.

QCCR1E141792_ 9.52
SM952P3_
SM952.unl

Improves the scalability of the Hot Topic Analytics (HTA)
solution and provides more meaningful HTA results.

QCCR1E140639_ 9.50
SM952p2_
SM950.unl

Enables SmartEmail to supports SharedInboxes via IMAP-S
and EWS.

QCCR1E135272_ 9.41
SM950_
SM941.unl

Enables the Collaboration functionality to work correctly when
you run Service Manager applications version 9.41 with version
9.50 or later of the Service Manager Server and clients.

QCCR1E131250_ 940 and 941
SM950_
SM940.unl

Fixes the issue that Smart Analytics cannot recognize the text
in a photo.

QCCR1E118520_ 9.34, 9.35,
SM950_
and 9.40
SM934.unl

Enables the enhanced query hash algorithm for the web client.

QCCR1E112815_ 9.34
SM950_
SM934.unl

Fixes an issue in which Time Period Management menus are
not displayed correctly due to incorrect menu condition settings.

QCCR1E112012_ 9.34+PD4,
SM950_
9.35+PD4
SM934.unl

Solves the issue that PD Framework components (including
Condition Editor , Query Editor , Workflow Editor, and Task
Planner) do not work correctly if an earlier version of the
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Unload

Applicable
applications
version
Description
applications is running on the 9.50 RTE and web tier.
Note: This unload is required if you are running 9.34 or 9.35
applications with Process Designer Content Pack 4
applied.

QCCR1E99207_
SM950_
SM934.unl

9.34 and
9.35

Enables Service Manager to lazy load global lists. This reduces
the login time in environments that contain a large number of
global lists.

QCCR1E66893_
SM950_
SM934.unl

9.34, 9.35,
9.40, and
9.41

Enables the Document Engine to enforce application-level
security for web service Retrieve requests.

How to load an unload file
Tip: Service Manager 9.52 only supports application versions 9.34 and later. If your application is
version 9.34 or later, we recommend that you use Unload Manager to make a backup of the files
that will be modified by an unload file, because Unload Manager can create a backup of your old
data during the installation of the unload; you can also use Database Manager to backup the files
instead. If your application version is not supported, please upgrade your applications to a
supported version.
For detailed steps, search for the Load an unload file topic in Service Manager 9.52 Help Center.

Web tier installation
The web tier update consists of a compressed file, sm9.52.6008-P6_Web_Tier.zip, which contains the
installation files (the .war, .ear, and .unl files) that are required to install the Service Manager web tier.
Installing the new web tier will upgrade your web client to this release level.
For detailed deployment steps, see Install the Service Manager web tier in the Service Manager 9.52
Help Center.

New customers
You only need to install the new web tier using the .war or .ear file from the sm9.52.6008-P6_Web_
Tier.zip file in this release.

Service Manager (9.52)

Page 55 of 68

Patch 6 Release Notes

Existing customers
To upgrade your web tier to this patch level, you must back up and uninstall your old web tier, and then
install the new web tier. To keep your custom changes, you must back up your customized files and
then merge your customizations into the new deployment.
To install the new web tier, follow these steps:
1. Make the necessary backups. For more information about how to do this, see Web tier backout
instructions.
2. Delete or uninstall the existing web tier .war (or the .ear) file.
3. Clear the cache of your web application server.
4. Deploy the new webtier-9.52.war file or webtier-ear-9.52.ear file.
Note: It is best practice to deploy with a unique context root. For example, /webtier-9.52.
5. Use a diff utility to compare the new web tier’s web.xml file against your backed-up version to
ensure that any new parameters are properly merged into the files used in your final deployment.
Do this for application-context.xml as well as any other files you may have customized (such as
style sheets and splash screens).
6. Make any new customizations that are necessary for your deployment.
7. Restart the web application server.
8. Check the version by clicking the HPE logo (About HP Service Manager) icon.
The web tier version should be: 9.52.6008-P6.

Web tier application unload installation
The web tier package in this release includes the following unload files.

Unload

Applicable
applications
version

Description

QCCR1E153165_ 9.52
SM952P6_
SM952.unl

Enables the drill-down functionality in a vertical bar report to
work correctly.

QCCR1E154335_ 9.50, 9.51,
SM952P6_
and 9.52
SM950.unl

Enables the Affect CIs fields to show the display name in the
Predefined Additional Task Fields of a planned task.
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Unload

Applicable
applications
version

Description

QCCR1E146520_ 9.50, 9.51,
SM952P3_
and 9.52
SM950.unl

Displays the display value for a combo box field in a hover-over
form.

QCCR1E137739_ 9.50
SM951_
SM950.unl

Enables the use of external libraries when you use 9.50 apps.

QCCR1E129149_ 9.41
SM950_
SM941.unl

Enables To-Do Alerts to be automatically acknowledged
without the user having to click the Acknowledge button.

QCCR1E125775_ 9.41
SM950_
SM941.unl

Enables IT users to manually trigger context-aware search.
Additionally, enables context-aware search to be enabled from
ESS.

QCCR1E124742_ 9.34, 9.35,
SM950_
and 9.40
SM934.unl

Merges the module configuration requests that are sent from
the web client to the server during the login process. This helps
to reduce the login time.

QCCR1E116757_ 9.40 and 9.41
SM950_
SM940.unl

Enables look up function support for the security manual list
type setting.

QCCR1E112070_ SM 9.34
SM950_
SM934.unl

For Service Catalog User Selection multi-selection support.

QCCR1E104944_ SM 9.41
SM950_
SM941.unl

Enables a fix that hides the User Selections of Service Catalog
items if their Visible Condition is set to false.

Windows client installation
Note: No features are being added to the Service Manager Windows (Eclipse) client. We
recommend that Service Manager administrators deploy one of the other three clients (web client,
SRC client, or Mobility client) to end users. You still need the Windows client to perform
administrative tasks.
The Windows client update consists of a compressed file, sm9.52.6008-P6_Windows_Client.zip,
which contains the executable installation files of the new Windows client. Installing the new Windows
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client will upgrade your Windows client to this patch level. This version of the Windows client comes
with an updated version of JRE 8.
For installation instructions, see Install the Service Manager Windows Client in Service Manager9.52
Help Center.
Note: The Windows client installer will also install the Client Configuration Utility in the <Service
Manager installation path>\Client\ClientConfiguration directory. To run the utility, double-click the
confutil.bat file in this directory. However, we recommend that you use the web client if you want
to provide end users with a customized client.

New customers
You only need to install the new Windows client.

Existing customers
You need to back up and uninstall the old Windows client, and then install the new Windows client.
To install the new Windows client, follow these steps:
1. Stop the Service Manager Windows client.
2. Make necessary backups. For details, see Windows client backout instructions.
3. Uninstall the Service Manager Windows client. (Your connection and personalized settings are
retained.)
4. Run setupclient.exe to install the new client.
5. Check the version in Help > About Service Manager Client.
The client should be Release: 9.52.6008-P6.

Service Request Catalog (SRC) installation
Service Manager 9.52p6 includes the SRC package (src9.52p6.1909221.zip), which contains:
l

The SRC deployment file (src-9.52p6.war)

l

Unload files for SRC 9.52.p6 and for previous versions

Unload file naming convention
The unload files use the following naming convention: <CR_ID>_SRCxxxPxx_SMxxx.unl, where:
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l

<CR_ID>: The identification number of the applications defect that the unload file fixes. For
example, QCCR1E12345.

l

SRCxxxPxx: The minimum SRC patch level that requires the unload file. For example,
SRC9.52p6, which means the unload file comes with the SRC9.52 patch 6 and should be used for
patch 6 or higher.

l

SMxxx: The Service Manager applications version that requires the unload file. For example,
SM952, which means the unload file is intended only for Service Manager applications version 9.52.

Before you proceed, read Install Service Request Catalog (SRC) in Service Manager9.52 Help Center.

New customers
1. Deploy the src-9.52p6.war file by following the instructions in Install Service Request Catalog
(SRC).
2. Configure SRC 9.52p6 by following the instructions in Install Service Request Catalog (SRC).

Existing customers
1. Install SRC 9.52p6, as described above.
2. Migrate your customizations from the old deployment to SRC 9.52p6.

SRC application unload installation
This SRC package in this release includes the following unload files.

Unload file

Used
for
Introduced apps
in which
version
patch
(s)
Description

QCCR1E137462_ SRC
SRC952p1_
9.52p1
SM952.unl

9.52

Enables the "visible" and "mandatory" conditions in
SRC Tailoring .

QCCR1E139800_ SRC
SRC952P2_
9.52p2
SM952.unl

9.52

One service request requires one operator and one
group to approve, if the operator is a member of this
group and approves the request, the request is
automatically approved by the group.
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Unload file

Used
for
Introduced apps
in which
version
patch
(s)
Description

QCCR1E142430_ SRC
SRC9.52P3_
9.52p3
SM9.52.unl

9.52

The system displays the Pending Approvals count
correctly in Service Request Catalog.

SMA-SM Service Portal installation
This release does not contain a Service Portal package. The latest Service Portal has been shipped
with the Service Management Automation (SMA) suite.
The SMA suite is delivered based on ITOM Container Deployment Foundation (CDF). CDF is built to
run on many environments. Deploy your IT Operations Management suite on bare metal or a virtual
environment, or even in the cloud. CDF uses a native cloud toolset, including Docker technologies and
Kubernetes from the Cloud Native Computing Foundation (CNCF), which allows the management of
container-based applications at scale.
SMA is an analytics-driven service management solution for managing the entire service portfolio and
lifecycle within and beyond IT. To enable existing customers of Service Manager to take advantage of
the containerized services offered by SMA and keep their existing Service Manager implementations,
SMA supports mixed mode deployment.
SMA-SM Service Portal is normally released in a quarterly cadence. We recommend that you
download and install the latest version that supports Service Manager 9.5x. Suppose you want to
install SMA-SM Service Portal 2019.08, follow these steps in SMA suite documentation:
1. Before the SMA-SM Service Portal installation, you need to plan required hardware resources as
described in Plan your deployment.
2. Once the resources are available, deploy SMA in mixed mode and then set up SMA to work with
Service Manager. For details, see Set up SMA-SM.
3. If you encounter any problems, see the SMA troubleshooting documentation.
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Mobility client installation
Service Manager 9.52p6 includes a compressed file (sm9.52.6003-P6_Mobility.zip), which contains
the following files:
l

Mobility client installation file (webapp-9.52.6003.war)

l

Unload to fix the issue in QCCR1E123225 (QCCR1E123225_SM950_SM934.unl)

l

Unload to fix the issue in QCCR1E125623 (QCCR1E125623_SM950_SM934.unl)

l

Unload to support Service Manager 9.34 applications (MOBILITY_ESS_SM950_SM934.unl)
Note: The Service Manager 9.52p6 Mobility client supports Apache Tomcat 8.x web application
servers. Additionally, it can only work with Service Manager server 9.34 or later and applications
9.34 or later.

New customers
To install the new web client, follow these steps:
1. Load the unload files that are included in sm9.52.6003-P6_Mobility.zip.
For detailed steps, search for the Load an unload file topic in Service Manager 9.52 Help Center.
2. Deploy the webapp-9.52.6003.war file.
For more information about how to install the Service Manager 9.52p6 Mobility client, refer to
Install the Mobile Applications client in Service Manager 9.52 Help Center.

Existing customers
To install the new web client, follow these steps:
1. Uninstall the existing Mobility client.
2. Load the unload files that are included in sm9.52.6003-P6_Mobility.zip.
For detailed steps, search for the Load an unload file topic in Service Manager 9.52 Help Center.
3. Deploy the webapp-9.52.6003.war file.
For more information about how to install the Service Manager 9.52p6 Mobility client, refer to
Install the Mobile Applications client in Service Manager 9.52 Help Center.
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Knowledge Management (KM) Search
Engine installation
IDOL Search Engine
Service Manager 9.52 Smart Analytics includes a Smart Search feature based on the IDOL Search
Engine. If you want to use the IDOL Search Engine for Knowledge Management, you do not need to
install or upgrade the Solr Search Engine.
For more information on how to install and configure the IDOL Search Engine, see the Service Manager
Smart Analytics Administrator and User Guide.

Solr Search Engine
This release includes a package for the Solr Search Engine:
l

Knowledgemanagement folder: Contains updated files of the Solr Search Engine.
This patch embeds an openjdk folder in the Knowledgemanagement folder. You can find various
OpenJDK JRE versions for your Solr Search Engine as required.

l

\kmsolr_unloads\QCCR1E128475_SM950_SM940.unl: This unload is used to enable HTTPS
connections for the Solr Search Engine. Loading this unload will add a new option, SSL Enabled, in
the Knowledge Management Environment record (Knowledge Management > Administration >
Environment). See also the following HPE white paper:
Configuring FIPS Mode in Service Manager

l

km-import-9.52.zip: The installation files of KM Import Utility version 9.52.
Caution: The patch will upgrade your embedded Tomcat to version 8.5.42.
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New customers
1. Make sure that you have already installed Service Manager 9.52 (or above) server and clients.
2. Install the Service Manager 9.50 Solr Search Engine . For installation instructions, see the Service
Manager Knowledge Management Search Engine Guide.
3. Update the JDK installed on your search engine server host to JDK 8, if you have not already done
so.
You can update the JAVA_HOME environment variable to point to the specific OpenJDK JRE in the
openjdk folder. For example, C:\sm9.52.6008-P6_KM\knowledgemanagement\openjdk\jdk-linuxx86.
4. In Windows: in the Windows command line, run the following command to remove the old KM
Search engine windows service from the Solr search engine installation directory (if the service is
installed):
installasservice.cmd remove [nodetype]
Note: In this command, [nodetype] is a placeholder for "master" or "slave", depending on
whether the KM Search engine server is the master or a slave.
5. Make a note of the HTTP port and shutdown port that are defined in the <Solr installation
directory>/tomcat/conf/server.xml file. Then, remove the Tomcat folder in your Solr Search
Engine installation folder.
6. Extract the files in the knowledgemanagement folder in the 9.52 km patch .zip file to your Solr
Search Engine installation directory to overwrite your existing files.
7. In the Windows command line, run the following command to install the new KM Search engine
windows service from the Solr search engine installation directory:
installasservice.cmd install [nodetype]
Note: In this command, [nodetype] is a placeholder for "master" or "slave", depending on
whether the KM Search engine server is the master or a slave.
8. Change the HTTP port and shutdown port that is defined in the <Solr installation
directory>/tomcat/conf/server.xml file, according to the note you made in step 5.
9. Start your Solr Search Engine.
10. Configure your search servers and knowledgebases, and perform a full indexing for all of your
knowledgebases. For details, see the Service Manager Solr Search Engine Guide.
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Existing customers
Existing customers must install the Service Manager 9.50 Solr Search Engine first, and then apply the
Service Manager 9.52p6 Solr Search Engine patch.
1. Make sure that your Service Manager server and clients have upgraded to version 9.52.
2. Stop your Solr Search Engine.
3. Make a backup of your Solr Search Engine installation folder and other necessary backups.
4. Update the JDK installed on your search engine server host to JDK 8, if you have not already done
so.
You can update the JAVA_HOME environment variable to point to the specific OpenJDK JRE in the
openjdk folder. For example, C:\sm9.52.6008-P6_KM\knowledgemanagement\openjdk\jdk-linuxx86.
5. In Windows: in the Windows command line, run the following command to remove the old KM
Search engine windows service from the Solr search engine installation directory:
installasservice.cmd remove [nodetype]
Note: In this command, [nodetype] is a placeholder for "master" or "slave", depending on
whether the KM Search engine server is the master or a slave.
6. Back up the Tomcat folder in your Solr Search Engine installation folder. Then, remove the Tomcat
folder.
7. Extract the files in the knowledgemanagement folder in the 9.52 km patch .zip file to your Solr
Search Engine installation directory to overwrite your existing files.
Note: If you have customized files in the Tomcat folder, for example, server.xml, recover the
customizations from the backup you created in step 6.
8. In the Windows command line, run the following command to install the new KM Search engine
windows service from the Solr search engine installation directory:
installasservice.cmd install [nodetype]
Note: In this command, [nodetype] is a placeholder for "master" or "slave", depending on
whether the KM Search engine server is the master or a slave.
9. Change the HTTP port and shutdown port that is defined in the <Solr installation
directory>/tomcat/conf/server.xml file, according to your requirements.
10. If you are running a 9.3x version of the Service Manager applications, load QCCR1E91035_
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SM940_SM930.unl into your Service Manager system.
Caution: Skip this step if you are running the Service Manager 9.4x applications or higher
versions.
11. If your sm.ini file already contains the following line, remove it.
KMSearchEngineClass:com.hp.ov.sm.server.plugins.knowledgemanagement.solr.KMSolr
Search
o

Skip this step if you are running Service Manager 9.3x applications, or if you are running
the Service Manager 9.40 (or earlier) RTE.

o

This parameter is no longer needed for the Service Manager 9.52 RTE. If it is present in the
sm.ini file, a warning message will occur in the Service Manager server log (sm.log).

12. Remove the KMCores folder in your existing search engine web application folder (for example,
<Solr installation directory>/tomcat/webapps).
13. Restart your Solr search engine.
14. Restart the Service Manager service.
15. Perform a full re-index of all of your knowledgebases. For details, see the Service Manager Solr
Search Engine Guide.

Collaboration installation
This release does not contain an SM Collaboration package. The latest SM Collaboration package has
been shipped with the Service Manager 9.52 release. You can find the download links for the SM9.5x
patches and release notes from the Overview of Service Manager 9.5x Releases knowledge
document.

Smart Analytics installation
This release does not contain a Smart Analytics package. The latest Smart Analytics package has
been shipped with the Service Manager 9.52 release. You can find the download links for the SM9.5x
patches and release notes from the Overview of Service Manager 9.5x Releases knowledge
document.
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Identity Manager (IdM) installation
Service Manager9.52p6 includes a compressed file (idm-service-1.20.1.zip), which contains the
following files:
l

dataprotection-passwordtool-1.0.3-standalone.jar

l

idm-admin-console-1.20.0.war

l

The Identity Manager (IdM) service installation file (idm-service-1.20.1.war)

For more information about how to install and configure the IdM service, refer to Install and configure
the standalone IdM service in Service Manager 9.52 Help Center.

Additional information
l

Install Service Manager 9.52 in Service Manager 9.52 Help Center (for detailed instructions on how
to install Service Manager, including all backup and backout procedures)

l

Service Manager Support Matrix
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Send documentation feedback
If you have comments about this document, you can contact the documentation team by email. If an
email client is configured on this system, click the link above and an email window opens with the
following information in the subject line:
Feedback on Patch 6 Release Notes (Service Manager 9.52)
Just add your feedback to the email and click send.
If no email client is available, copy the information above to a new message in a web mail client, and
send your feedback to docs.feedback@microfocus.com.
We appreciate your feedback!
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